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BOOST-IR Infrared (IR) BoosterPack™ Plug-in Module

The BOOST-IR BoosterPack™ Plug-in Module can be plugged into a LaunchPad™ Development Kit for
simple integration of infrared (IR) transceiver functionality. LaunchPad developers can use this
BoosterPack to start developing remote control applications using the on-board keypad, IR LED
transmitter, and IR receiver + demodulator.

Infrared modulation can be simplified by using on-chip IR Modulation Logic, which can be found on select
MSP430 ultra-low-power microcontrollers within the MSP430FRxx MCU series.

Explore IR communication using the MSP430FR4xx and MSP430FR2xx microcontrollers

Tl Designs are also available to help accelerate development using IR transceiver capabilities. These
designs contain documentation, design files, and test data to minimize design overhead.

Download a full reference design leveraging the MSP-EXP430FR4133 LaunchPad and BOOST-IR
BoosterPack

Figure 1. BOOST-IR BoosterPack

BoosterPack, LaunchPad, MSP430, Code Composer Studio, E2E are trademarks of Texas Instruments.
All other trademarks are the property of their respective owners.
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1 Getting Started

1.1 Introduction

The BOOST-IR BoosterPack™ Plug-in Module can be plugged into a LaunchPad™ Development Kit for
simple integration of infrared (IR) transceiver functionality. LaunchPad developers can use this
BoosterPack to start developing remote control applications using the on-board keypad, IR LED
transmitter, and IR receiver + demodulator.

Infrared modulation can be simplified by using on-chip IR Modulation Logic, which can be found on select
MSP430 ultra-low-power microcontrollers within the MSP430FRxx MCU series.

Explore IR communication using the MSP430FR4xx and MSP430FR2xx microcontrollers

Tl Designs are also available to help accelerate development using IR transceiver capabilities. These
designs contain documentation, design files, and test data to minimize design overhead.

Download a full reference design leveraging the MSP-EXP430FR4133 LaunchPad and BOOST-IR
BoosterPack

1.2 Key Features
* IR LED transmitter
* IR receiver and demodulator
e 4x4 membrane keypad
» 20-pin BoosterPack standard for use with any LaunchPad
» Compatibility with different IR signal-generation methods

1.3 What's Included

1.3.1 Kit Contents
e 1 x BOOST-IR BoosterPack Plug-in module
e 1 x Quick Start Guide

1.3.2 Software Examples
* MSP-EXP430FR4133 LaunchPad and BOOST-IR demos (see Section 3)
— IR Emitter and Receiver
— IR Learning Mode

1.4 Next Steps: Looking Into the Provided Code

After the EVM features have been explored, the fun can begin. It's time to open an integrated
development environment (IDE) and start looking at the code examples. Section 3 describes the example
projects available to make it easy to understand the provided software.
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2 Hardware
Figure 2 shows an overview of the BOOST-IR module.
External

Power J1.1and J2.20
Connector

- External power provided through J5
- Remove R1 to disconnect from LaunchPad 3V3
- Allows increasing transmit power via R2

IR Transmit

J1.40rJ2.19
LED

- IR Transmit controlled by jumper
- Transmit power controlled by R2 (47 ohm)
- Increasing transmit power requires external power

ISREEUEINTI | sciect the IR transmit
Jumper control method

- Hardware IR module is featured on some LaunchPads
- Hardware IR module simplifies IR transmit software
- PWM is featured on all LaunchPads
- PWM requires additional software for IR transmission

Hardware IR Module
J1.4

s
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s
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r
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PWM IR Transmit
J2.19

Rx/Tx LED
Indicator

- LED blinks to signal both a receive and a transmit
- LED is controlled by hardware on IR BoosterPack (IR_RX signal)
- LED is not directly controllable by any LaunchPad pins

IR Receive
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\ J
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J2.18

Module

- IR receiver and demodulator
- Receive any 38 kHz IR signal
- Replace IR receive module for other frequencies
- TSOP58430 30 kHz
- TSOP58433 33 kHz
- TSOP58436 36 kHz
- TSOP58438 38 kHz (Populated)
- TSOP58440 40 kHz
- TSOP58456 56 kHz

Keypad Out 1 J1.2
Keypad Out 2 J1.3
Keypad Out 3 J1.6
Custom Keypad Out 4 J1.8
Keypad Keypad In 1J2.13
Keypad In 2 J2.12
Keypad In 3 J2.11
Keypad In 4 J1.5

Figure 2. BOOST-IR Overview
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2.1 Hardware Features

N

BoosterPack
Standard

1.1 BoosterPack Pinout

BOOST-IR Pin map

BoosterPack standard

g

PWM Out (@)
-H(SPLCS Wireless {GPIO H(Y)

{ GPIO**E

[se1 MOSI

MISO

-(SPI CS Display HGPIO H()
SPLCS Other  { GPIO H())

Figure 3. BoosterPack Pinout

{GrIO H()j

The IR BoosterPack adheres to the 20-pin LaunchPad and BoosterPack pinout standard (see Figure 3).

This standard was created to aid compatibility between LaunchPad and BoosterPack tools across the Tl
ecosystem.

The 20-pin standard is compatible with the 40-pin standard that is used by other LaunchPad kits like the

MSP-EXP430F5529LP. This allows for 20-pin BoosterPacks to be used with 40-pin LaunchPads.

The BOOST-IR intentionally does not use the 1°C and SPI pins to allow other BoosterPacks that use these
pins to be stacked together with the IR BoosterPack. This BoosterPack does not have both male and
female headers to support stacking on top. This is because the keypad is too large, and in most
applications this keypad would be on the top. To stack other BoosterPacks along with BOOST-IR, use
them lower in the "stack" with BOOST-IR on top.

More information about compatibility can also be found at http://www.ti.com/launchpad.
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2.1.2 Membrane Keypad
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Figure 4. Membrane Keypad Connections

The membrane keypad is a 4x4 matrix keypad, controlled by 4 Keypad Out pins (columns), and 4 Keypad
In pins (rows). Without any buttons pressed, the columns and rows are not connected to each other.
When a button is pressed, it connects its corresponding column pin with its corresponding row pin.

To detect any key presses, the connection of the row pin to the column pin must be detected. This is
accomplished by configuring the Keypad Out pins as outputs, and Keypad In pins as inputs. The Keypad
Out pins are toggled high one at a time, while the Keypad In pins are read for any changes. This allows
the exact key to be determined in the 4x4 matrix.

As an example, refer to the Figure 4 keypad layout. If the bottom left button is pressed, the Keypad Out 4
pin is now connected to the Keypad In 1 pin. The host MCU starts reading the keypad matrix by toggling
Keypad Out 1 high (while keeping all other Keypad Out pins low), and reads all Keypad In pins low. This
is because Keypad Out 1 is still not connected to any Keypad In pins by a button press. The host MCU
then toggles Keypad Out 2 high, and reads all Keypad In pins still low. Eventually, the MCU toggles
Keypad Out 4 high, and reads that Keypad In 1 has now transitioned to high. Recall that the bottom left
button connects Keypad Out 4 with Keypad In 1, forcing the input row to read high. The MCU maps out
this connection and knows that the bottom left button was pushed, because that is the intersection point of
Keypad Out 4 and Keypad In 1. The MCU can now perform the action that corresponds to the key press.

It may seem like a key press can be missed with this procedure, but it is happening many times per
second, allowing for any key press to be detected. It is possible for keys to go undetected due to key
"ghosting"” in a matrix keypad, but that is outside the scope of this brief overview. This only occurs when
multiple buttons are pressed at the same time, and there are ghost key detection algorithms to prevent
any misinterpretations.

NOTE: The Keypad Out 2 (J1.3) pin is connected to the UART receive pin on the BoosterPack
standard. On most 20-pin LaunchPads (MSP-EXP430G2, MSP-EXP430FR5969, MSP-
EXP430FR4133), the Keypad Out 2 pin is also connected to the LaunchPad backchannel
UART pin. For proper operation of the Keypad, disconnect the UART RX jumper on the
LaunchPad isolation block.
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2.1.3 IR Transmit
Figure 5 shows the schematic of the IR transmit circuit.

IR Emitter
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Figure 5. IR Transmit Circuit

2.1.3.1 IR Transmit Overview

To transmit an IR signal, an infrared (IR) LED is toggled to blink the LED. Using IR protocols, messages
can be read such as commands from remote controls. More information on IR protocol can be found in
Infrared Remote Control Implementation With MSP430FR4xx (SLAA644) and also in Section 3.1.1.

Because the IR LED requires high currents to transmit longer distances, this LED is not controlled directly
with a general purpose 10 pin from the MCU. Instead a switching circuit that allows current to flow directly
from the main power source is used. See Section 2.2 for more information on power and Section 6 for the
schematics.

2.1.3.2  Setting IR Transmit Power

To set the current of the IR LED, resistor R2 (47 Q) is used. This resistor can be adjusted to change the
IR LED transmit power. Decreasing R2 increases the power through the IR LED, which increases the
range of the remote.

NOTE: Increasing the IR transmit power may draw more current than supported from the
LaunchPad. Check the specific LaunchPad user's guide to make sure that enough power
can be provided, or use external power (see Section 2.2.2).

2.1.3.3 IR Transmit Selection
IR transmit can be controlled by two different pins, selectable by jumper J4 (see Figure 2).

Setting the J4 jumper to the left side selects the hardware IR module (J1.4), which is only featured on
some LaunchPads, such as the MSP-EXP430FR4133. The hardware IR module simplifies the software
needed for IR transmission, because the hardware handles the protocol.

NOTE: When using the hardware IR module (J1.4), this pin is connected to the UART transmit pin
on the BoosterPack standard. On some LaunchPads, such as the MSP-EXP430FR4133, the
hardware IR module pin is also connected to the LaunchPad backchannel UART pin. For
proper operation of the hardware IR module, it is recommended to disconnect the UART TX
jumper on the LaunchPad isolation block.
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Setting jumper J4 to the right selects PWM control (J2.19), which can be used on any LaunchPad. The
PWM method requires additional software to control the PWM pin according to the IR protocol.

2.14 IR Receive
Figure 6 shows the schematic of the IR receive circuit.
IR _Receiver
Q
(__W
IR_RX
VS ta
( out |—IRRX n
GND 180nE | 10UF
TSOP58438
GND
Figure 6. IR Receive Circuit
The IR receive module receives and demodulates the incoming signal. The default IR receiver supports IR
transmission at 38 kHz. This is the most commonly used IR frequency for use in remote controls. If
another frequency is needed, the IR receive module can be replaced with a drop-in replacement that
supports another frequency (see Table 1). More information on IR protocol can be found in Infrared
Remote Control Implementation With MSP430FR4xx (SLAA644) and also in Section 3.1.1.2.
Table 1. IR Receiver Replacement Options
Part Number Receive Frequency
TSOP58430 30 kHz
TSOP58433 33 kHz
TSOP58436 36 kHz
TSOP58438 38 kHz (Populated)
TSOP58440 40 kHz
TSOP58456 56 kHz
The IR receive module is very sensitive and receives almost all of the IR transmissions from its own IR
LED. This is mostly unavoidable without physically altering the BoosterPack. Make sure that your firmware
compensates for receiving its own transmissions by ignoring them or verifying that the proper output was
sent.
2.2 Power
The board was designed to be powered either by the attached LaunchPad or by an external source
through the external power connector.
221 LaunchPad Power
This is the default power configuration for the BOOST-IR. In this configuration, power is provided through
the 3V3 (J1.1) pin on the BoosterPack headers. The 3V3 pin powers everything on the IR BoosterPack,
including IR transmit and receive.
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External Power

There are a few reasons why you may want to provide external power, including higher IR transmit power,
changing to a different voltage, or using a battery to go "wireless." To provide external power, use the
following procedure.

1. Disconnect BOOST-IR power from the LaunchPad power source
(a) Option 1: Remove the 3V3 jumper on the LaunchPad isolation block

In this case, the MCU is also powered by the external source; make sure that the voltage is within
the MCU device voltage operation specification.

(b) Option 2: Remove R1 on the BOOST-IR to completely disconnect LaunchPad and BoosterPack
power

(i) In this case, the LaunchPad must provide power to its own MCU.

(iiy If the LaunchPad and BoosterPack have different operating voltages, IR communication may
not function properly.

2. Connect the external power supply.

After these steps are complete, you should be able to operate the IR BoosterPack with an external
voltage.

2.3 Design Files
23.1 Hardware
Schematics can be found in Section 6. All design files including schematics, layout, bill of materials
(BOM), Gerber files, and documentation are available in a zip folder (SLAR104).
2.3.2 Software
All design files including TI-TXT object-code firmware images, software example projects, and
documentation are available in the LaunchPad specific software folders. To see which LaunchPads
feature BOOST-IR examples, refer to the "What's Included" section on the BOOST-IR tool folder.
2.3.3 Quick Start Guide
The BOOST-IR Quick Start Guide is SLAU614.
2.4 Hardware Change Log
Table 2. Hardware Change Log
PCB Revision Description
Rev 1.0 Initial Release
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3 TI Design and Software Examples

3.1 TI Design: BOOST-IR + MSP-EXP430FR4133 IR Remote Control

{if TEXAS INSTRUMENTS

TI Designs Design Features
TI Designs provide the foundation that you need  Implements ASK IR modulation
including methodology, testing, and design files « 38-kHz onboard demodulator

to quickly evaluate and customize the system. Tl
Designs help you accelerate your time to market.

System Description

* 4x4 membrane keypad

» Jumper to configure IR generation method -
support for most LaunchPad kits

The BOOST-IR BoosterPack is an easy-to-use « |R Emitter and Receiver examp|es

plug-in module for adding Infrared (IR)

communications to your Launchpad design. It o

contains everything that you need to start Featured Applications

developing IR communication with your « TV Remote Control

Launchpad, including a keypad, IR LED  Air Conditioner Remote Control
transmitter, and IR receiver + demodulator. i
Design Photo

* IR Learning Mode example

Design Resources
TIDM-BOOST-IR-

Design Folder

REMOTE
MSP-EXP430FR4133 Product Folder
BOOST-IR Product Folder
MSP430FR4133 Product Folder
“ ﬂ Find an answer:
TI E2E™ MSP430 E2E Support Forum
Community

Block Diagram

External
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3.11 System Design Theory

The following sections discuss the IR modulation and demodulation schemes used in this design. For
additional information about IR remote control theory and implementing IR protocols on FR4xx devices,
see the application note Infrared Remote Control Implementation with MSP430FR4xx (SLAA644).

3.1.1.1 ASK Modulation

The MSP-EXP430FR4133 + BOOST-IR Remote Control sends and receives ASK modulated IR signals
with a 38-kHz carrier frequency. 38 kHz is one of the most common IR carrier frequencies for remote
control applications and is used by many TV and air conditioner manufacturers.

In ASK modulation, two signals (the higher-frequency carrier, and the envelope) are combined to form the
modulated signal. The envelope contains the data to be sent, under one of many different standard
encoding schemes (for example, pulse position, pulse distance, pulse width, or Manchester encoding).
The carrier is simply a high frequency signal. When the two signals are combined, the carrier frequency is
output whenever the envelope is high, and the signal is held low when the envelope is low. Figure 7
shows an example of an IR modulated signal using Pulse Position encoding.

logic 1 logic O logic 1 logic 1 logic O logic 1
(carrier modulated pulse) (space)

“— ¢ ¢ X X X X >

(DS S S W)
carrier

Figure 7. Pulse Position Encoding (ASK)

3.1.1.2 IR Modulation Logic on MSP430FR4133

The MSP430FR4133 device includes some logic to help enable IR modulation, inside of the SYS module.
This logic block allows the outputs signals from some timer modules in the device (producing the carrier
frequency) to be combined with an envelope generated by another timer module, the output of the
USCI_AO module, or with a software controlled IRDATA line. In addition, the Timers can optionally be
cascaded. TA1 can select to use TAO as the clock source so that TA1 is essentially counting ticks of the
TAO PWM output signal. This arrangement allows for flexible and configurable generation of all different
kinds of ASK and FSK modulation schemes. Figure 8 shows an overview of the modules involved in
internal IR signal generation on the FR4133.
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IR Modulation (SYS)

P2.6/UCA1TXD/UCA1SIMO

From UCA1TXD/UCA1SIMO

SYSCFG1.IRDATA SYSCFG1.IRMSEL SYSCFG1.IREN

SYSCFG1.IRDSSEL SYSCFG1.IRPSEL

Figure 8. IR Modulation Logic Blocks in MSP430FR4133

Figure 9 shows the ASK IR Modulation signal generation used in the example software for this Tl Design,
found in the MSP-EXP430FR4133 Software Examples. TAOCCR2 output is used as the carrier frequency,
and is ANDed with TALCCR2 which is generating the envelope, before the final resulting signal is brought
out on the output pin.

Therefore to generate the signal, TAOCCRO and TAOCCR2 are set once at the beginning of the code to
generate a 38-kHz PWM for the carrier signal. For each bit to be sent, the TAICCRO and TA1CCR2
values are updated to generate a PWM with the correct envelope timing for sending a 0 or 1 using Pulse
Distance Encoding.
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Figure 9. ASK IR Generation on MSP430FR4133

3.1.1.3 ASK Demodulation

The receiver uses a photodiode to convert the IR light to current. A transimpedance amplifier is frequently
used to convert the current into voltage, which passes through a gain amplifier and filter before
demodulation, which removes the carrier signal. Then the demodulated signal, which is essentially just the
envelope signal now that the carrier has been removed, can be connected directly the MCU for decoding
(see Figure 10).

Receiver's

Demodulation MCU

Figure 10. IR Demodulation

The BOOST-IR BoosterPack features a Vishay TSOP59348 IR Receiver device. This device performs all
of the steps above, stripping off the carrier signal, and then provides the envelope directly to the FR4133
TAO.2 input. The Timer AO module is then used in capture mode to record the edges of the signal. The
pulse length is calculated from these capture values to determine if a 0 or 1 was received using pulse
distance encoding.

3.1.1.4  Pulse Distance Encoding and Protocol

The software IR emitter and receiver examples included with this TI Design use a Pulse Distance protocol
for communication between two LaunchPads + BoosterPacks. This protocol is similar to that used on
many commercially available remote control devices. In Pulse Distance Encoding, each bit is a carrier
modulated pulse and a space — the carrier modulated pulse width is constant, while the width of the space
varies to indicate a logic O or logic 1.
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Figure 11. Pulse Distance Encoding

The provided IR Emitter and Receiver code uses a standard timing for remote controls using pulse
distance protocol. Logic 1 is defined as a 560-us carrier modulated period followed by a 1690-us space
period. Logic 0 is defined as a 560-us carrier modulated period followed by a 560-us space period. The
data frame starts with a Leading Code of 9-ms modulated period followed by a 4.5-ms space period.

After the Leading Code, the data payload begins. The payload consists of 4 bytes:

1. 1 address byte

2. The same address byte inverted

3. 1 command byte

4. The same command byte inverted

The address byte is used to identify the device so that receivers can ignore signals from other IR remotes
that are intended for other devices. The example code has arbitrarily chosen 0x55 for the address byte.
The command byte is the actual data that you want to send — in this example it is a byte that corresponds
to the number of the key that was pressed. The protocol follows the address byte with an inverted version
of itself, and the command byte with an inverted version of itself. This is to help catch any errors in the

communication to increase robustness, and is a standard feature of the pulse distance protocol used by
many remote controls.

After the payload is transmitted, the Data Frame ends with a tail pulse to indicate the end of the packet.
This tail is a 560 us carrier modulated pulse.

Figure 12 shows the full Data Frame Format.

9 ms 4.5 ms ADDRESS ADDRESS COMMAND COMMAND
PP >« > |« rle— >
LSB MSB | LSB MSB | LSB MSB | LSB MSB

Leading Code 000 1 0 1 0 1 1 1 i1 01 01 O0j1 0 1 1 01 1 00 1 00 1 OO0 1 |Tail

Figure 12. Pulse Distance Protocol, Data Frame Format

3.1.1.5 IR Learning Mode

For some applications like universal TV remotes, it is useful to have a device that can learn different IR
codes. To do this, the device needs to be able to receive an IR signal from another device, record it, and
then later be able to reproduce it on command. The MSP430FR4133 is an FRAM device, allowing for a
large amount of nonvolatile storage that can be quickly and easily accessed with no extra steps needed
(like is needed for writing Flash) . FRAM can be written just like RAM at speeds up to 8 MHz — perfect for
logging data. The FRAM also has near-infinite write cycles, so the IR codes can be reprogrammed
frequently without risk of wearing out the memory. Because of this, the device is a great candidate for
implementing IR applications that require "learning" IR codes. The example software for this Tl Design
includes a Learning Mode example.
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3.1.2

The learning mode example code provided uses a Timer A capture input to receive an IR signal stripped
of its 38-kHz carrier, and records the edge timing of the signal. This timing information is stored in FRAM
for later use. Later, when the code should reproduce the same signal for TX, it simply reads the timing
information from FRAM and uses this to set the envelope Timer values for the transmission until the
transmission is complete.

In this type of application, the device does not need to decode or understand any protocol — it simply

needs to be able to reproduce the signal on command. This code therefore supports all different ASK
encoding and protocols, allowing it to be able to copy and repeat IR commands from a wide variety of
sources like consumer television remotes.

The only limits are:

e 38-kHz carrier
This is due to the frequency of the Vishay demodulator present on the BoosterPack. This part can be
replaced and the code modified if other carrier frequencies are needed.

* Quantity of FRAM available on the device compared to the length and number of codes to store

The code timing information is stored in FRAM, so the amount of available FRAM in your code
determines how many different codes, and the length of the codes, that can be learned.

Hardware

The MSP430FR4133 device has built-in IR modulation capabilities. The internal IR modulation is
configurable and flexible. It supports both ASK and FSK modulation, which allows implementation of a
variety of IR protocols. For more information on the IR modulation capabilities of the FR4133 device, see
the MSP430FR4xx and MSP430FR2xx Family User's Guide (SLAU445). For more information on how to
implement different remote control IR protocols using the FR4133 IR features, see the application report
Infrared Remote Control Implementation With MSP430FR4xx (SLAA644).

3.1.21  MSP-EXP430FR4133 LaunchPad

The MSP430FR4133 device is the first device in TI's FRAM technology platform to combine an LCD driver
and infrared modulation functions with FRAM. FRAM is a cutting edge memory technology, combining the
best features of flash and RAM into one nonvolatile memory. More information on FRAM can be found at
www.ti.com/fram.

Device features include:

» 1.8-V to 3.6-V operation

* Up to 16-MHz system clock and 8-MHz FRAM access

» 15.5KB of FRAM and 2KB of SRAM

» Ultra-low-power operation

e Low-power liquid crystal display (LCD) with LPM3.5 support

« Two timer blocks and two serial interfaces (SPI, UART, or I>C)
* RTC counter (real-time counter module) with LPM3.5 support
* Analog: 10-channel 10-bit ADC with window comparator

» Capacitive Touch I/Os on all GPIO pins (60) to enable touch applications
» Digital: CRC16

For more information on the hardware and capabilities of the MSP-EXP430FR4133 LaunchPad, see the
MSP430FR4133 LaunchPad Development Kit (MSP-EXP430FR4133) User's Guide (SLAU595).
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Figure 13. MSP430FR4133 Pinout
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3.1.3 Software Examples

There are two BOOST-IR software examples included with the MSP-EXP430FR4133 LaunchPad (see
Table 3), which can be found in the MSP-EXP430FR4133 Software Examples.

Table 3. Software Examples

Demo Name LaunchPad Required Description More Details
This example uses two MSP-EXP430FR4133 LaunchPad kits
IR Emitter and and BOOST-IR BoosterPack modules to communicate. One )
Receiver MSP-EXP430FR4133 LaunchPad is programmed with the Emitter code, and the Section 3.1.5

other is programmed with the Receiver code.

This example uses one MSP-EXP430FR4133 LaunchPad with
IR Learning Mode MSP-EXP430FR4133 | the BOOST-IR BoosterPack to copy and repeat IR sequences Section 3.1.6
from some other IR emitter (for example, a TV remote control)

3.14 Development Environment Requirements

To use any of the software examples with the LaunchPad, you must have an integrated development
environment (IDE) that supports the MSP430FR4133 device.

Table 4. IDE Minimum Requirements for MSP430FR4133

Code Composer Studio™ IDE IAR Embedded Workbench™ IDE
CCS v 6.1 or later IAR EW430 v7.0 or later

For more details on where to download the latest IDE, see Section 4.2.

3.141 CCS

CCS 6.1 or higher is required. When CCS has been launched and a workspace directory chosen, use
Project > Import Existing CCS Eclipse Project (see Figure 14). Browse to the desired demo project
directory that contains main.c. This is IR_Emitter_and_Receiver or IR_Learning_Mode.

Browse For Folder ﬁ

Select root directory of the projects to impart

18 Computer <
-'“_- Metwork
4 | BOOST-IR

J IR_Emnitter_and_Receiver

. IR_Learning_Meode

Folder: IR_Emitter_and_Receiver

| Make New Falder | E oK 1 | Cancel |

b - A

Figure 14. Directing the Project>Import Function to the Demo Project

Selecting the \CCS folder also works. The CCS-specific files are located there.
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When you click OK, CCS should recognize the project and allow you to import it. The indication that CCS
has found the project is that its name is shown in the Import CCS Eclipse Projects window with a check
mark to the left of it, as shown in Figure 15.

'« Import CCS Eclipse Projects uﬂlﬂ-]

e

Select CCS Projects to Import 3

Select a directory to search for existing CC5 Eclipse projects,

'

@ Select search-directory:  C:\Users\a0282836\ Desktop\BOOST-IR\IR_Er

"1 Select archive file: Browse

Discovered projects:

[¥] =7 IR_Emitter_and_Receiver [C:\Users\al282836" Desktop\BOOST: Select All
Deselect All
4 T 3 Refresh

[C] Automatically impoert referenced projects found in same search-directory
Copy projects into workspace

Open the Resource Explorer and browse available example projects...

'i? I Finish J I Cancel

Figure 15. When CCS Has Found the Project

Sometimes CCS finds the project but does not show a checkmark; this might mean that your workspace
already has a project by that name. You can resolve this by renaming or deleting that project. (Even if you
do not see it in the CCS workspace, be sure to check the workspace’s directory on the file system.)

Make sure to check Copy projects into workspace, then click Finish to complete the import process. For
the IR Emitter and Receiver project, note that the project contains two separate pieces of code — one for
programming the device for transmit and one for programming the device to receive. This is handled
within one project by using build configurations. To change between Emitter and Receiver, right-click on
the CCS project and go to Build Configurations > Set Active and then select either IR Emitter or IR
Receiver.

3.14.2 IAR

IAR 6.10.2 or higher is required. To open the demo in IAR, click File>Open>Workspace..., and browse to
the *.eww workspace file inside the \IAR folder of the desired demo. All workspace information is
contained within this file.

The \IAR folder also has an *.ewp project file. This file can be opened into an existing workspace by
clicking Project>Add-Existing-Project....

Although the software examples have all of the code required to run them, IAR users may download and
install MSP430Ware, which contains MSP430™ libraries and the Tl Resource Explorer. These are already
included in a CCS installation (unless the user selected otherwise).
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3.15 IR Emitter and Receiver Software Example

This code shows how to send and receive IR signals using the BOOST-IR BoosterPack. The example
requires two sets of MSP-EXP430FR4133 LaunchPad kits and BOOST-IR BoosterPack modules to
communicate with each other.

3.15.1 Source File Structure

This project is organized in multiple files. This makes it easier to navigate and reuse parts of it for other
projects. Table 5 describes each file in the project.

Table 5. Source Files and Folders

Name Description
FR4133_IR_BP_RX.c IR receiver main function, IR setup and processing, and other functions
FR4133_IR_BP_TX.c IR emitter main function, IR setup and processing, and other functions
HAL_FR4133LP_Board.c Board initialization functions, keypad scanning functions
HAL_FR4133LP_LCD.c LCD initialization functions, LCD display functions

3.1.5.2 IR Emitter Example

The IR Emitter code sends messages to the other board. Whenever a button is pressed on the
BoosterPack, a command corresponding to the key pressed is sent to the other board. You can tell that
the IR emitter code is loaded into the BoosterPack because the LCD radio symbol and TX are displayed.
An LED is lit when the transmission is happening. The button that is pressed is also displayed on the LCD.

This example makes use of the IR features of the MSP430FR4133 device for generating an ASK
modulated signal. TAICCR?2 generates the envelope for the data to be sent, and TAOCCR2 generates the
carrier frequency. The timers are connected internally and using the SYSCFG settings are combined to
generate the IR signal output on a pin, which goes to the IR emitter LED on the BoosterPack. For more
details on the IR generation using the IR modulation features of the MSP430FR4133, and information on
how data is encoded in the examples, see Section 3.1.1.

3.1.5.3 IR Receiver Example

The IR Receiver code receives messages from the emitter board. Whenever a signal is received from the
other board (i.e. when a button on the keypad is pressed on the other BoosterPack), and the Receiver
BoosterPack receives the signal, the name of the button pressed is displayed on the LaunchPad LCD. For
example, if the button POWER is pressed on the emitter BoosterPack, and the signal is received by the
receiver BoosterPack, "POWER" is displayed on the receiver LaunchPad LCD and the LED on P4.0
blinks.

This example uses the IR receiver and demodulator on the BoosterPack to strip the carrier off of the
received signal. This means that the signal into the MSP430 is just the envelope signal. The timer capture
registers are used to measure the high and low pulses to decode the data. For more details on the IR
demodulation and decode using the BoosterPack hardware and the timers of the MSP430FR4133, and for
information on how data is encoded in the examples, see Section 3.1.1.
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3.16

IR Learning Mode Software Example

The Learning Mode example can receive IR sequences from a remote control or other device and store
them in memory associated with different buttons on the BoosterPack keypad. Then the sequences can
be transmitted from the BoosterPack by pushing the keypad buttons, and used to control IR devices.

3.16.1 Source File Structure

This project is organized in multiple files. This makes it easier to navigate and reuse parts of it for other
projects. Table 6 describes each file in the project.

Table 6. Source Files and Folders

Name Description
FR4133_IR_BP_Learn.c IR Learning mode main function, IR setup and processing, and other functions
HAL_FR4133LP_Learn_Board.c Board initialization functions, keypad scanning functions
HAL_FR4133LP_LCD.c LCD initialization functions, LCD display functions

3.1.6.2 IR Learning Mode Example

3.1.7

When the COPY button is pressed, the firmware enters learning mode. Push the button on the keypad
that you want to train, and then transmit the signal to be learned from a device like a TV remote. Continue
this until all desired buttons are assigned, and then press OK to return to normal transmit mode. Now,
when a button is pressed, the stored signal is transmitted.

While receiving signals in learning mode, the MSP430FR4133 device uses the timer capture function to
record the time between signal edges for the high and low pulses. The sequence of pulse lengths is
stored in FRAM for later use to generate the same signal when the button is pressed. For more details
about how the learning mode software works, see Section 3.1.1.5.

Note that the IR receiver and demodulator on the BoosterPack is tuned for 38-kHz carrier frequency. This
is one of the most common carrier frequencies used by many remote control manufacturers for a number
of devices. If communication needs to be with a device that uses a different carrier (for example, 40 kHz),
this component can be replaced with a different receiver and demodulator device.

Testing

3.1.7.1 Test Environment

For current measurements
Test instrument: Fluke 87, set to HA measurement

Voltage supply at 3.3 V applied to MSP-EXP430FR4133 3V3 and GND pins on J6 of LaunchPad. All
jumpers on LaunchPad J101 removed to exclude the eZ-FET from the measurement. JP1 for LED is also
removed to remove the indicator LED (not transmission LED) from the measurement as well.

For range measurements

Measured with two MSP-EXP430FR4133 + BOOST-IR, one programmed as Emitter, and one
programmed as Receiver. Environment was a normal home/office environment with normal ambient
overhead white fluorescent lighting and with no obstructions between the LaunchPads. Distance was
increased until the Receiver LaunchPad no longer received correct codes from Transmitter LaunchPad.

Range was tested with two different resistor values to show the impact of the resistor size on IR signal
strength. Changing this resistor is described in Section 2.1.3.2.
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3.1.7.

3.1.8

2 Test Data

Table 7 shows current measurements both with and without the BOOST-IR module connected to the
board. This is to show the contribution of just the MSP430 versus the consumption of the whole system.

Table 7. Current Consumption

Software Idle Current With BOOST-IR Idle Current
(No Buttons Pressed) (MSP-EXP430FR4133 Only)
IR Emitter 830 pA 4.0 pA
IR Receiver 1059 pA 238 pA

Current consumption when the BOOST-IR module is present is much higher due to the consumption of
the IR demodulator TSOP58238 module. The TSOP58238 module on its own consumes approximately
800 pA, so it makes up the bulk of the current consumption of the system. For product designs where IR
RX function is not needed, only TX, this device could be eliminated and a lower current consumption in
idle mode more like the MSP-EXP430FR4133 current for IR Emitter shown above could be achieved.
Note that while sending a transmission by pressing a button, the current peaks — this peak current
depends on the R value that you have selected for R2 (which also affects range as detailed below).

The current consumption for IR Receiver mode of just the MSP-EXP430FR4133 was measured at
approximately 238 pA. This is higher than the IR Emitter code, because while the IR Emitter code can
remain in LPM3 until a button is pressed, the IR Receiver must have the timer capture set up with the
timer module sourced from the high-frequency SMCLK to have a high enough timer resolution to decode
the signals. To keep SMCLK enabled while idle, IR Emitter code can only enter LPMO, because this is the
lowest power mode in which SMCLK is on. See the MSP430FR4133 data sheet (SLAS865) for more
details about low-power modes (LPMs) and current consumption.

Table 8. Range Testing

Resistor Used for R2 (Q) Range (meters)
47 8m
4.7 20m

By default, the BOOST-IR module comes with a 47-Q resistor for R2. R2 controls the TX current for the IR
LED. This has a direct effect on the brightness of the IR LED and therefore the range of transmission that
is possible. When testing with the TX and RX code examples, the maximum range for transmitting from
one BOOST-IR to the other was 8 meters with the default 47-Q R2 — at longer distances, transmission and
reception became unreliable. When the value of R2 was changed to 4.7 Q, the LED is driven with more
current and able to transmit much farther. In our test, we achieved a 20-meter transmission distance with
this resistor. Using a smaller R2 allows for longer transmission distances at the expense of increased
current consumption. For transmission power this high, external power must be provided, because the
MSP-EXP430FR4133 and other LaunchPads are unable to provide this much power directly. In a
production design, experimentation should be used to help determine the best resistor value to achieve
the desired transmission range while still fitting within the design’s power budget.

Design Files
For software files, see the MSP-EXP430FR4133 Software Examples
For hardware files, see:

» BOOST-IR Hardware Design Files and Section 2 and Section 6.
 MSP-EXP430FR4133 Hardware Design Files
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4

4.1

4.2

4.3

Additional Resources

Tl LaunchPad Portal

More information about LaunchPad kits, supported BoosterPack modules, and available resources can be
found at:

* TI's LaunchPad portal: information about all LaunchPad kits from Tl for all MCUs

Download CCS, IAR, or Energia

Although the files can be viewed with any text editor, more can be done with the projects if they're opened
with a development environment like Code Composer Studio™ (CCS), IAR, or Energia.

MSP430Ware and Tl Resource Explorer

MSP430Ware is a complete collection of libraries and tools. It includes a driver library (driverlib), graphics
library (grlib), and many other software tools. MSP430Ware is optionally included in a CCS installation or
can be downloaded separately. IAR users must download it separately.

MSP430Ware includes the Tl Resource Explorer, for easily browsing tools. For example, Figure 16 shows
all the software examples in the tree. Inside Tl Resource Explorer, these examples and many more can be
found and easily imported into CCS with one click.

' T1Rescurce Explorer 23

Packages: 5% Devices: | All

enter search keyword

4 £ MSP430ware -
. F Devices
4 ' Development Tools
. B0 MSP-EXP430G2
. B0 MSP-EXP430F5529LP
. B0 MSP-EXP430FR5969
. ®5 430BO0OST-SENSEL
. B0 430B0O0ST-SHARPYA
. B0 BOOST-IR
. @0 MSP-EXP430F5529
. B0 MSP-EXP430F5435
. B0 MSP-EXPCC430RFx
. B MSP-EXP430FR5739
. B0 e7430-Chronos
. B0 £7430-RF2500
. B0 e7430-F2013
. B0 FlowEsI GUI
. 0 MSP-54430-5UB1GHZ
. ®0 MSP-FET430 (USE Debugging Interface)
. B MSP-FET430UIF (USE Debugging Interface)
. L MSP-GANG (GANG Programmer)
- % Target Boards
@ EM430F5137RFI00
i@ EM430FE137RFI00
- [ Libraries =

m

Figure 16. BOOST-IR Software Examples in Tl Resource Explorer
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4.4 The Community

4.4.1 TI E2E™ Community

Search the forums at http://e2e.ti.com. If you cannot find your answer, post your question to the
community.

4.4.2 Community at Large

Many online communities are dedicated to the LaunchPad and BoosterPack ecosystem — for example,
http://www.430h.com. You can find additional tools, resources, and support from these communities.

5 FAQs
Q: Why does one column on my keypad not work?

A: On some LaunchPads, one of the column pins is connected to the UART RX pin through the
backchannel UART. Disconnect the UART RX jumper on the LaunchPad isolation block.

Q: Why do I receive everything that | transmit?

A: The receiver module is sensitive, and receives almost every transmission sent by the IR LED. Make
sure that your firmware ignores the messages that you send.

SLAU598A—December 2014—Revised July 2015 BOOST-IR Infrared (IR) BoosterPack™ Plug-in Module 23

Submit Documentation Feedback
Copyright © 2014-2015, Texas Instruments Incorporated


http://www.ti.com
http://e2e.ti.com/
http://www.43oh.com/
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU598A

13 TEXAS

INSTRUMENTS
Schematics www.ti.com
6 Schematics
Hardware design files can be downloaded from www.ti.com/lit/zip/slar104.
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Changes from December 5, 2014 to July 20, 2015 Page

¢ Throughout document, changed the link destinations for the MSP-EXP430FR4133 Software Examples and MSP-
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NOTE: Page numbers for previous revisions may differ from page numbers in the current version.
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STANDARD TERMS FOR EVALUATION MODULES

Delivery: Tl delivers Tl evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or
documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.

11

1.2

EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility
evaluation, experimentation, or scientific analysis of Tl semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

Limited Warranty and Related Remedies/Disclaimers:

21

2.2

2.3

These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License
Agreement.

Tl warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date Tl delivers such EVM
to User. Notwithstanding the foregoing, Tl shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (¢) User has not paid on time. Testing and other quality control
technigues are used to the extent Tl deems necessary. Tl does not test all parameters of each EVM.
User's claims against Tl under this Section 2 are void if User fails to notify Tl of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by Tl and that are determined by TI not to conform to such warranty. If Tl elects to repair or
replace such EVM, Tl shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

WARNING

Evaluation Kits are intended solely for use by technically qualified,
professional electronics experts who are familiar with the dangers
and application risks associated with handling electrical mechanical
components, systems, and subsystems.

User shall operate the Evaluation Kit within TI's recommended
guidelines and any applicable legal or environmental requirements
as well as reasonable and customary safeguards. Failure to set up

and/or operate the Evaluation Kit within TI's recommended
guidelines may result in personal injury or death or property
damage. Proper set up entails following TI's instructions for
electrical ratings of interface circuits such as input, output and
electrical loads.

NOTE:

EXPOSURE TO ELECTROSTATIC DISCHARGE (ESD) MAY CAUSE DEGREDATION OR FAILURE OF THE EVALUATION
KIT; TI RECOMMENDS STORAGE OF THE EVALUATION KIT IN A PROTECTIVE ESD BAG.
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3

Regulatory Notices:

3.1

3.2

United States
3.1.1 Notice applicable to EVMs not FCC-Approved:

FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 For EVMs annotated as FCC — FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

« Reorient or relocate the receiving antenna.

« Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
« Consult the dealer or an experienced radio/TV technician for help.

Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247
Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:

(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) I'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de I'appareil doit
accepter tout brouillage radioélectrique subi, méme si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.
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3.3

Concernant les EVMs avec antennes détachables

Conformément a la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour I'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique a l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas lintensité nécessaire a I'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d'usage et ayant un gain admissible maximal et lI'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour I'exploitation de
I'émetteur
Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/Isds/ti_ja/general/eStore/notice_01.page HZAEMAIC
BAThBEAETY M, R—RIZDOVTRE, ROEZHEZEBIEEL,
http://www_tij.co.jp/Isds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by Tl as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):

1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal
Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.
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3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/Isds/ti_ja/general/eStore/notice_02.page

ENBRMERBECOVTOBERTY REBEVICEIBOEEBEICOVTR, ROEIBREIBEBSEEV, hitp/
/www.tij.co.jp/Isds/ti_ja/general/eStore/notice_02.page

3.4 European Union

3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.
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4 EVM Use Restrictions and Warnings:

4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT
LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.

4.2 User must read and apply the user guide and other available documentation provided by Tl regarding the EVM prior to handling
or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:

4.3.1 User shall operate the EVM within TI's recommended specifications and environmental considerations stated in the user
guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a Tl
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a Tl field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User's handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent Tl provides information on the availability and function of EVMs, Tl attempts to be as accurate
as possible. However, Tl does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

6. Disclaimers:

6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT
LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." Tl DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.
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8.

10.

Limitations on Damages and Liability:

8.1

8.2

General Limitations. IN NO EVENT SHALL Tl BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,
INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER Tl HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO Tl BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

Return Policy. Except as otherwise provided, Tl does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)

will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and Tl may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated
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IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS”
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD
PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable
standards, and any other safety, security, or other requirements. These resources are subject to change without notice. Tl grants you
permission to use these resources only for development of an application that uses the Tl products described in the resource. Other
reproduction and display of these resources is prohibited. No license is granted to any other Tl intellectual property right or to any third
party intellectual property right. Tl disclaims responsibility for, and you will fully indemnify Tl and its representatives against, any claims,
damages, costs, losses, and liabilities arising out of your use of these resources.

TI's products are provided subject to TI's Terms of Sale (www.ti.com/legal/termsofsale.html) or other applicable terms available either on
ti.com or provided in conjunction with such Tl products. TI's provision of these resources does not expand or otherwise alter TI's applicable
warranties or warranty disclaimers for TI products.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated
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